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NOTICES 

 

⚫ For in vitro diagnostic use only. 

⚫ If this product is used with Microlab NIMBUS IVD, Microlab STARlet IVD, Seegene 

NIMBUS and Seegene STARlet, it provides a maximum of 5 separate runs. 

⚫ AIOS combines Seegene STARlet sold by Seegene with real-time PCR equipment (CFX96 

Dx, Manufacturer: Bio-Rad) and plate sealer (manufacturer: SAMICK THK) to form an 

automated linkage structure of nucleic acid extraction to PCR. 

⚫ This test has been validated for the following specimen types: cervical swab, self-

collected vaginal specimen and liquid-based cytology specimens. This test has not 

been validated for any other types of specimens. 

⚫ Store DNA samples at -70℃ until use and keep on ice during use. 

⚫ Sensitivity of the assay may decrease if samples are repeatedly frozen/thawed or stored for 

a longer period of time. 

⚫ Workflow in the laboratory should proceed in a unidirectional manner.  

⚫ Reliability of the results depends on adequate specimen collection, transport, storage and 

processing procedure. 

⚫ Wear disposable gloves and change them before entering different areas. Change gloves 

immediately if contaminated or treat them with DNA decontaminating reagent.  

⚫ Supplies and equipment must be dedicated to working areas and should not be moved from 

one area to another. 

⚫ Do not pipette by mouth. 

⚫ Do not eat, drink or smoke in laboratory work areas. Wear disposable powder-free gloves, 

laboratory coats and eye protections when handling specimens and reagents. Wash hands 

thoroughly after handling specimens and test reagents. 

⚫ Avoid contamination of reagents when removing aliquots from reagent tubes. The use of 

sterile aerosol resistant disposable pipette tips is recommended. 

⚫ Do not pool reagents from different lots or from different tubes of the same lot. 

⚫ Do not use the product after its expiry date. 

⚫ Do not reuse all disposable items. 

⚫ Use screw-capped tubes and prevents any potential splashing or cross-contamination of 

specimens during preparations.   

⚫ Please be careful not to contaminate reagents with extracted nucleic acids, PCR products, 

and positive control. To prevent the contamination of reagents, the use of filter tips is 

recommended. 
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⚫ Use separated and segregated working areas for each experiment. 

⚫ To avoid contamination of working areas with amplified products, open PCR reaction tubes 

or strips only at designated working areas after amplification. 

⚫ Store positive materials separated from kit’s reagents. 

⚫ Laboratory safety procedures (refer to Biosafety in Microbiological and Biomedical 

Laboratories & CLSI Documents) must be taken when handling specimens. Thoroughly 

clean and disinfect all work surfaces with 0.5% sodium hypochlorite (in de-ionized or 

distilled water). Product components (product residuals, packaging) can be considered as 

laboratory waste. Dispose of unused reagents and waste in accordance with applicable 

federal, state, and local regulations. 

⚫ Expiry date is 13 months at ≤-20℃ from the date of manufacture. Please refer to label for 

final expiry date. 

⚫ Seegene NIMBUS and Seegene STARlet are the same equipment as the Microlab NIMBUS 

IVD and Microlab STARlet IVD, although the manufacturer is different. Since there are no 

hardware changes on the device, the test results are the same. 

⚫ The brand name of “CFX96™ Real-time PCR Detection System-IVD” is changed to 

“CFX96™ Dx system”. Since there are no hardware changes to the systems, it is expected 

to obtain the same results from both systems. 

⚫ “CFX Manager™ Dx Software v3.1” is an upgrade version of “CFX Manager™ Software-

IVD v1.6”. The upgraded software includes enhancements to the “Run” menu. These 

enhancements do not impact the results of data analysis; therefore, results will be the 

same. 

⚫ This kit is intended to aid in the differential diagnosis of target pathogen infections;  

Human papillomaviruses. 
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INTENDED USE 

 

The AnyplexTM II HPV HR Detection is a qualitative in vitro test for the detection of 14 high risk 

HPV types in liquid-based cytology, cervical swab and self-collected vaginal specimens. This 

assay specifically identifies not only HPV 16 and HPV 18 but also other 12 individual high risk 

HPV genotypes (31, 33, 35, 39, 45, 51, 52, 56, 58, 59, 66 and 68) at clinically relevant infection 

levels. 

 

The AnyplexTM II HPV HR Detection is indicated: 

 

a) To screen patients with ASC-US (atypical squamous cells of undetermined significance) 

cervical cytology results to determine the need for referral to colposcopy. The results of this test 

are not intended to prevent women from proceeding to colposcopy. 

b) To screen patients with ASC-US cervical cytology results to assess the presence or absence 

of HPV 16, HPV 18 and other 12 individual high risk HPV genotypes (31, 33, 35, 39, 45, 51, 52, 

56, 58, 59, 66 and 68). 

c) To be used with cervical cytology to adjunctively screen to assess the presence or absence of 

HPV 16, HPV 18 and other 12 individual high risk HPV genotypes (31, 33, 35, 39, 45, 51, 52, 

56, 58, 59, 66 and 68). 

d) To be used as a primary screening test to identify women at increased risk for the 

development of cervical cancer or the presence of high-grade disease. 

e) To be used as a primary screening test to assess the presence or absence of HPV 16, HPV 

18 and other 12 individual high risk HPV genotypes (31, 33, 35, 39, 45, 51, 52, 56, 58, 59, 66 

and 68). 

 

The result from the AnyplexTM II HPV HR Detection, together with the physician's assessment of  

cytology history, other risk factors, and professional guidelines, may be used to guide patient 

management. 
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PRINCIPLES AND PROCEDURE OVERVIEW 

 

1.  Principles 

 

The AnyplexTM II HPV HR Detection represents Seegene’s proprietary technologies and is 

based on a TOCETM technology which makes it possible to detect multi-pathogens in a single 

fluorescence channel on real-time PCR instruments. 

In current melting curve analysis, temperature differences are often observed among DNAs that 

have high sequence variation, resulting in issues the field of clinical diagnostics where accurate 

and reproducible test results are critical. However, TOCETM technology is designated not to be 

affected by sequence variations; therefore, it guarantees consistent Tm values.  

The AnyplexTM II HPV HR Detection can perform multiplex examination by either End point-

CMTA (End point-Catcher Melting Temperature Analysis) or cyclic-CMTA (cyclic-Catcher Melting 

Temperature Analysis) method. cyclic-CMTA method which represents a new class of molecular 

tests can discriminate major pathogen in the co-infected samples. The AnyplexTM II HPV HR 

Detection is a multiplex real-time PCR assay that permits the simultaneous amplification, 

detection and differentiation of target nucleic acids of 14 high-risk HPV types (16, 18, 31, 33, 

35, 39, 45, 51, 52, 56, 58, 59, 66 and 68) as well as Internal Control (IC). 

In PCR, efficiency can be reduced by inhibitors that may be present in the clinical specimens. 

An Internal Control(IC) is incorporated into the product as an endogenous whole process 

control in order to monitor nucleic acid isolation, and to check for possible PCR inhibition. The 

IC is co-amplified with the target nucleic acids within the clinical specimens. The AnyplexTM II 

HPV HR Detection uses a human house-keeping gene as an endogenous IC which can ensure 

purification of DNA, verification of PCR reaction and clarification of cell adequacy from each 

specimen. 

The Uracil-DNA glycosylase (UDG)-dUTP system is employed in the AnyplexTM II HPV HR 

Detection. The UDG-dUTP system is commonly used when performing PCR to eliminate 

amplicon carry-over using UDG excises uracil residues from DNA by cleaving the N-glycosylic 

bond. 
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2.  Procedure Overview 

 

 

 

 

 

 

 

  

 

Nucleic acid 

Samples 

(Liquid-based cytology,  

cervical swab and self-collected 

vaginal specimens) 

Nucleic Acid Extraction 

Amplification and detection using  

Anyplex
TM

 II system 

Analysis of Results 
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BACKGROUND INFORMATION 

 

Human Papilloma Virus (HPV) infection is linked with cervical cancer. HPV can be divided into 

“high-risk (HR)” and “low-risk (LR)” groups on the basis of their association with cervical lesions.  

Therefore, it is very important to know which type of HPV is infected in patients to prevent 

cancer development and transmission of disease. Currently, commercially available major 

products to diagnose HPV are based on probe-hybridization method to detect and/or genotype 

HPV. However, main defects of the probe-hybridization based methods are high false positive 

rate due to cross-reactivity between probes and various kinds of viral DNA or PCR amplicons 

used for hybridization. Here we are introducing an innovative HPV detection/genotyping assay 

system which amplifies only specific targets without any cross reactivity and is automated in 

detection using real-time PCR method. Eventually the AnyplexTM II HPV HR Detection only 

specifically detects true HPV and accurately genotypes them. It also contains endogenous 

Internal Control to check any inhibition that might occur during PCR reaction. 

Cervical cancer, which progresses from the precancerous stage to invasive cancer, has 7-20 

years of precancerous stage. In addition, high-risk HPV group has been reported to be 

associated with the development of cervical cancer; especially, HPV16 and HPV18 about 70% 

of cervical cancer cases. Therefore, early diagnosis using HPV DNA testing is necessary to 

prevent cancer progression. AnyplexTM II HPV HR Detection can identify 14 high-risk HPV types 

including HPV16 and 18 at the same time. 
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REAGENTS 

 

The reagents contained in one kit are sufficient for 100 reactions. 

Order information (        HP7E00X) 

 

AnyplexTM II HPV HR Detection 

Symbols Contents Volume Description 

 
4X HPV HR TOM 500 μL 

TOCE Oligo Mix (TOM): 

- Amplification and detection reagents 

 
EM1 500 μL 

- DNA polymerase 

- Uracil-DNA glycosylase (UDG) 

- Buffer containing dNTPs 

 
HPV HR PC1 50 μL 

Positive Control(PC) : 

- Mixture of pathogen clones  

 
HPV HR PC2 50 μL 

Positive Control(PC) : 

- Mixture of pathogen clones 

 
HPV HR PC3 50 μL 

Positive Control(PC) : 

- Mixture of pathogen clones  

 
RNase-free Water 1,000 μL Ultrapure quality, PCR-grade 

 
User manual 

 

Accessory product – analysis software 

Seegene Viewer * 

*The analysis software is provided by Seegene Inc. or regional manager. Please use 

Seegene Viewer beyond V3. 
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The reagents contained in one kit are sufficient for 25 reactions. 

Order information (       HP10380Z) 

 

AnyplexTM II HPV HR Detection 

Symbols Contents Volume Description 

 
4X HPV HR TOM 125 μL 

TOCE Oligo Mix (TOM): 

- Amplification and detection reagents 

 
EM1 125 μL 

- DNA polymerase 

- Uracil-DNA glycosylase (UDG) 

- Buffer containing dNTPs 

 
HPV HR PC1 50 μL 

Positive Control(PC) : 

- Mixture of pathogen clones  

 
HPV HR PC2 50 μL 

Positive Control(PC) : 

- Mixture of pathogen clones 

 
HPV HR PC3 50 μL 

Positive Control(PC) : 

- Mixture of pathogen clones  

 
RNase-free Water 1,000 μL Ultrapure quality, PCR-grade 

 
User manual 

 

Accessory product – analysis software 

Seegene Viewer * 

*The analysis software is provided by Seegene Inc. or regional manager. Please use 

Seegene Viewer beyond V3. 
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STORAGE AND HANDLING 

 

All components of the AnyplexTM II HPV HR Detection should be stored at ≤-20℃. All 

components are stable under recommended storage conditions until the expiry date stated on 

the label. The performance of kit components is not affected for up to 5 freezing and thawing. If 

the reagents are to be used only intermittently, they should be frozen in aliquots. 

 

 

MATERIALS REQUIRED BUT NOT PROVIDED 

 

⚫ Disposable powder free gloves (latex or nitrile) 

⚫ Pipettes (adjustable) and sterile pipette tips 

⚫ 1.5 mL microcentrifuge tube 

⚫ Nucleic acid extraction kit (see Nucleic Acid Extraction)  

⚫ Proteinase K (For SEEPREP12TM, Cat. No.P4850, SIGMA) 

⚫ Ice maker 

⚫ Desktop centrifuge  

⚫ Vortex mixer 

⚫ CFX96TM Real-time PCR Detection system (Bio-Rad) 

⚫ CFX96TM Dx System (Bio-Rad) 

⚫ Optical Flat 8-Cap Strips (Cat. No. TCS0803, Bio-Rad) 

⚫ Low-Profile 0.2 mL 8-Tube Strips without Caps (white color, Cat. No. TLS0851, Bio-Rad) 

⚫ Hard-Shell® 96-Well PCR Plates, low profile, thin wall, skirted, white/white (Cat. No. 

HSP9655, Bio-Rad) 

⚫ Hard-Shell® 96-Well PCR Plates, low profile, thin wall, skirted, white/white, barcoded (Cat. 

No. HSP9955, Bio-Rad) 

⚫ Vial Cap Management System (Cat. No. 6600532-01, Hamilton) 

⚫ AIOS (Cat. No. SG72100, Seegene) 

⚫ Pierceable cap (Cat. No. 922119, SPL) (for AIOS use only) 

⚫ Permanent Clear Heat Seal (Cat. No. 1814035, Bio-Rad)* 

⚫ PX1 PCR plate sealer (auto-sealer, Cat. No. 181-4000, Bio-Rad)* 

⚫ Clean bench 

* Make sure to use the heat seal and the plate sealer listed above together. 
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PROTOCOL 

 

1.  Specimen Collection, Storage, and Transport 

Note: All samples have to be treated as potentially infectious materials. Only those sample 

materials are permitted, which are collected, stored and transported attending strictly the 

following rules and instructions : 

 

Liquid-based cytology specimen 

Cervical swab specimen 

Self-collected vaginal specimen 

 

Note: To ensure a high sample quality, the specimens should be transported as fast as possible. 

The specimens have to be transported at the indicated temperature conditions. 

 

A.  Specimen Collection 

 

Liquid-based cytology specimen 

⚫ Follow the manufacturer’s instructions for collecting cervical cell specimens into ThinPrep® 

(HOLOGIC, USA) or SurePathTM (Becton-Dickinson, USA) or CellPreserv (Kolplast, Brazil) 

media. 

 

Cervical swab specimen 

For the collection of cervical swab specimen, please use following materials : 

⚫ Cervical swabs can be collected and transported in the following mediums : 

- eNAT®  (COPAN, Italia) 

Cervical specimen collection kit Manufacturer Cat. No. 

eNAT® PM 2ML L-SHAPE APPLICATOR COPAN 606CS01L 

 

⚫ Leave the swab in the transport medium. Close and label the sample container. Stick 

closely to the instructions given for storage and transport. 

⚫ Please follow a recommended protocol to collect columnar and squamous epithelium cells 

after removal of the cervical mucus. 
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Self-collected vaginal specimen 

⚫ For the collection of self-collected vaginal specimen, please use following material: 

-  Rovers® Evalyn® Brush (Rovers Medical Devices B.V., Netherlands) 

-  Qvintip® (Aprovix AB, Sweden) 

Self-sampling device Manufacturer Cat. No. 

Rovers® Evalyn® Brush Rovers Medical Devices B.V. 380500131 

Qvintip® Aprovix AB 10-002 

 

⚫ Self-collected vaginal specimen can be collected and stored in ThinPrep®  PreservCyt®  

Solution. 

⚫ Follow each manufacturer's instructions of sampling device and transport media for 

collection and storage of vaginal cell specimens. 

 

B.  Specimen Storage & Transport 

Specimen Media 
Storage & Transport 

Note 
Temp. Duration* 

Cervical 

swab 
eNAT®  

2~8℃ 

& Room 

Temperature** 

90 days 

- Performance may be affected by 

prolonged storage of specimens. 

- Specimens should also adhere to 

local and national instructions for 

transport of pathogenic material. 

Liquid-based 

cytology 

ThinPrep® 

SurePathTM 

CellPreserv 

Self- 

collected 

vaginal 

specimen 

ThinPrep® 

* Duration: Specimen collected from the period prior to the test including specimen storage and 
transport prior to the test. 

** Optimum temperature for transport is 2~25℃. 
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2.  Nucleic Acid Extraction 

Various manufacturers offer nucleic acid extraction kits. Use right amount of sample according to the 

protocol in use. The following extraction kits have been validated for use with this kit. 

 

A.  Pre-treatment of Liquid-based cytology specimen 

⚫ Equilibrate samples to room temperature (19~25℃). 

⚫ Centrifuge 1 mL of liquid-based cytology specimen for 15 minutes at 15,000 x g (13,000 rpm). 

 

⚫ The supernatant has to be discarded. Afterwards, the recommend volume (200~300 µL, See 

Recommended Vol. of 2-C, D) should be resuspended in 1X PBS by vortexing thoroughly to 

redissolve. 

Note: Process pre-treatment step using lysis buffer in extraction kit not 1X PBS if the samples are 

collected in SurePathTM medium and would be analyzed with Microlab NIMBUS IVD, Microlab 

STARlet IVD, Seegene NIMBUS or Seegene STARlet. 

Note: ThinPrep®  and SurePathTM media can be processed without pre-treatment when using 

Microlab NIMBUS IVD, Microlab STARlet IVD, Seegene NIMBUS or Seegene STARlet. 

Note: CellPreserv and self-collected vaginal specimen do not require a pre-treatment step. 

Note: SurePathTM and CellPreserv have not been validated with STARMag 96 X 4 Viral DNA/RNA 

200 C Kit. 

Note: CellPreserv has not been validated with STARMag 96 ProPrep C (Plate Type) and STARMag 

96 ProPrep C (Tube Type) 

⚫ Follow the manufacturer’s protocol. 

 

B.  Cervical swab specimen 

 

⚫ Equilibrate samples to room temperature (19~25℃). 

⚫ For cervical swab specimens which contain a swab in the transport media specimens should be 

mixed by vortexing. 

⚫ The caps from specimen tubes have to be removed carefully to avoid contaminations. Any 

excess mucus in the specimen should be removed at this time by collecting it on the swab. Any 

residual liquid from the mucus and the swab should then be expressed by pressing the swab  

against the slide of the tube. Finally the swab and the mucus should be removed and discarded. 

⚫ eNAT®  specimens may be processed directly out of their primary container. 
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C.  Manual Nucleic Acid Extraction Kits 

 

Note: Please use the recommended specimen and elution volumes as indicated below. For all 

others, refer to the manufacturer’s protocol. 

Extraction Kit Manufacturer Cat. No. Recommended Vol. 

QIAamp® DNA Mini Kit* QIAGEN 51304 
Specimen: 200 µL 
Elution: 50 µL 

Ribo_spin vRD** 
(Viral RNA/DNA Extraction Kit) 

GeneAll 
302-150 

SG1701*** 
Specimen: 200 µL 
Elution: 50 µL 

 

* Process lysis step using 180 µL of ATL buffer instead of AL buffer in case of SurePathTM media. 

** Ribo_spin vRD kit is not compatible with SurePathTM media.  

*** If you would like to purchase the above products from Seegene Inc., please use this catalog 

number. 

 

D.  Automated Extraction Systems 

 

Note: Please use the recommended volumes of specimen and elution as indicated below. For others, 

refer to the manufacturer’s protocol. 

 

D-1.  Microlab NIMBUS IVD 

Note: See Microlab NIMBUS IVD operation manual. 

Automated Extraction Systems Manufacturer Cat. No. Recommended Vol. 

Microlab NIMBUS IVD Hamilton 65415-02* - 

STARMag 96 X 4  

Universal Cartridge Kit 
Seegene 744300.4.UC384 

Specimen: 300 µL 

Elution: 100 µL 

STARMag 96 X 4 

Viral DNA/RNA 200 C Kit** 
Seegene EX00013C 

Specimen: 300 µL 

Elution: 100 µL 

* If you would like to purchase the above products from Seegene Inc., please use this catalog 

number. 

** SurePathTM and CellPreserv have not been validated with STARMag 96 X 4 Viral DNA/RNA 200 C 

Kit. 
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D-2.  Microlab STARlet IVD 

Option: Pre-analytic System (See Vial Cap Management System operation manual) 

Automated Pre-analytic System Manufacturer Cat. No. 

Vial Cap Management System Hamilton 6600532-01* 

* If you would like to purchase the above products from Seegene Inc., please use this catalog 

number. 

 

Note: See Microlab STARlet IVD operation manual. 

Automated Extraction Systems Manufacturer Cat. No. Recommended Vol. 

Microlab STARlet IVD  Hamilton 173000-075* - 

STARMag 96 X 4  

Universal Cartridge Kit 
Seegene 744300.4.UC384 

Specimen: 300 µL 

Elution: 100 µL 

STARMag 96 X 4  

Viral DNA/RNA 200 C Kit** 
Seegene EX00013C 

Specimen: 300 µL 

Elution: 100 µL 

* If you would like to purchase the above products from Seegene Inc., please use this catalog 

number. 

** SurePathTM and CellPreserv have not been validated with STARMag 96 X 4 Viral DNA/RNA 200 C 

Kit. 

 

D-3. Seegene NIMBUS 

Note: See Seegene NIMBUS operation manual. 

* SurePathTM and CellPreserv have not been validated with STARMag 96 X 4 Viral DNA/RNA 200 C 

Kit. 

 

 

 

Automated Extraction System Manufacturer Cat. No. Recommended Vol. 

Seegene NIMBUS Seegene 65415-03 - 

STARMag 96 X 4  

Universal Cartridge Kit 
Seegene 

744300.4. 

UC384 

Specimen: 300 L 

Elution: 100 L 

STARMag 96 X 4  

Viral DNA/RNA 200 C Kit* 
Seegene EX00013C 

Specimen: 300 µL 

Elution: 100 µL 
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D-4. Seegene STARlet 

Option: Pre-analytic System (See Vial Cap Management System operation manual) 

Automated Pre-analytic System Manufacturer Cat. No. 

Vial Cap Management System Hamilton 6600532-01* 

* If you would like to purchase the above products from Seegene Inc., please use this catalog 

number. 

 

Option: Automated Linkage Structure (See AIOS operation manual) 

Automated Linkage Structure Manufacturer Cat. No. 

AIOS Seegene SG72100 

Note: Replace the cap of the Positive Control (PC) with a pierceable cap. After finishing the 

operation, replace the cap of the Positive Control (PC) with the original cap. 

Note: The pierceable cap is a single-use product and must be disposed of after one use. 

Note: If used with AIOS, this product can be used for maximum 3 separate runs. 

 

Note: See Seegene STARlet operation manual. 

* SurePathTM and CellPreserv have not been validated with STARMag 96 X 4 Viral DNA/RNA 200 C 

Kit. 

** STARMagTM S96H N Kit is designed and validated for the use with the configuration of Seegene 

STARlet with CO-RE 96 Probe Head. 

 

 

 

 

Automated Extraction System Manufacturer Cat. No. Recommended Vol. 

Seegene STARlet Seegene 67930-03 - 

STARMag 96 X 4  

Universal Cartridge Kit 
Seegene 

744300.4. 

UC384 

Specimen: 300 L 

Elution: 100 L 

STARMag 96 X 4  

Viral DNA/RNA 200 C Kit* 
Seegene EX00013C 

Specimen: 300 µL 

Elution: 100 µL 

STARMagTM S96H N Kit** Seegene 
EX00036P 

EX00037P 

Specimen: 300 L 

Elution: 60 L 
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D-5.  SEEPREP12TM 

Automated Extraction Systems Manufacturer Cat. No. Recommended Vol. 

SEEPREP12™ DiaSorin SPN1200* - 

SEEPREP12™ Viral NA Kit** DiaSorin SPN1004* 
Specimen: 240 µL 

Elution: 60 µL 

* If you would like to purchase the above products from Seegene Inc., please use this catalog 

number. 

** Proteinase K (20 mg/mL) is not included in this kit. 

 

⚫ Add 10 µL of proteinase K (20 mg/mL; purchase separately) to each 1.5 mL sample tubes. 

⚫ Transfer 240 µL of specimen to the tube containing 10 µL of proteinase K, mix by flicking the tube 

gently. 

⚫ The cartridge and assembled pump-tip are placed on the instrument. 

⚫ Place 1.5 mL elution tube onto the instrument. 

⚫ Press “CONTINUE” on the first screen to let the instrument initialize. 

⚫ Press “START PROTOCOL” on the SEEPREP12TM main menu. 

⚫ In Select protocol menu, press “SPN Viral NA-HT v.2.0”. 

⚫ In Select sample volume menu, press “250 µL” and in Select elution volume, press “60 µL”. 

 

⚫ Follow the onscreen instructions for loading the instrument. 

⚫ After all steps are completed, close the lid and start the run. 
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D-6.  NucliSENS® easyMAG® 

⚫ Proceed the extraction process using ‘generic protocol’. 

Automated Extraction System Manufacturer REF Recommended Vol. 

NucliSENS® easyMAG® bioMérieux 200111 

Specimen: 200 L 

Magnetic Silica: 50 L 

Elution: 100 L 

 

 

D-7. SEEPREP32 

⚫ Proceed the extraction process using ‘Pro-Protocol A’. 

Automated Extraction System Manufacturer REF Recommended Vol. 

SEEPREP32 Seegene SG71100 - 

STARMag 96 ProPrep (Plate Type) Seegene EX00009P 
Specimen: 200 μL 

Elution: 100 μL 

STARMag 96 ProPrep (Tube Type) Seegene EX00009T 
Specimen: 200 μL 

Elution: 100 μL 

STARMag 96 ProPrep C 

(Plate Type)* 
Seegene EX00017P 

Specimen: 200 μL 

Elution: 100 μL 

STARMag 96 ProPrep C 

(Tube Type)* 
Seegene EX00017T 

Specimen: 200 μL 

Elution: 100 μL 

 

* CellPreserv has not been validated with STARMag 96 ProPrep C (Plate Type) and STARMag 96 

ProPrep C (Tube Type). 
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E.  Summary 

Extraction Method Applicated sampling device 

Microlab NIMBUS IVD / Microlab STARlet IVD / 

Seegene NIMBUS / Seegene STARlet 8 

eNAT® , ThinPrep® , SurePathTM 1,2, 

CellPreserv 1 

SEEPREP12TM 3 eNAT® , ThinPrep®  7, SurePathTM 

NucliSENS® easyMAG® 4 eNAT® , ThinPrep®  7, CellPreserv 

QIAamp®  DNA Mini Kit 
eNAT® , ThinPrep® , SurePathTM 5, 

CellPreserv 

Ribo_spin vRD 

(Viral RNA/DNA Extraction Kit) 
eNAT® , ThinPrep® , CellPreserv 

SEEPREP32 eNAT® , ThinPrep® , CellPreserv 6 

1. SurePathTM and CellPreserv have not been validated with STARMag 96 X 4 Viral DNA/RNA 200 C Kit. 

2. If DNA is extracted from SurePathTM specimens with Microlab NIMBUS IVD, Microlab STARlet IVD, 

Seegene NIMBUS or Seegene STARlet, there is a possibility that the sensitivity could be reduced compared 

to other extraction methods. 

3. Only available for SEEPREP12TM Viral NA Kit. 

4. NucliSENS® easyMAG system 

5. Process lysis step using 180 µL of ATL buffer instead of AL buffer in case of SurePathTM media. 

6. CellPreserv has not been validated with STARMag 96 ProPrep C (Plate Type) and STARMag 96 ProPrep C 

(Tube Type). 

7. ThinPrep® media with self-collected vaginal specimens have not been validated with SEEPREP12™ and 

NucliSENS®easyMAG®. 

8. STARMagTM S96H N Kit is designed and validated for the use with the configuration of Seegene STARlet 

with CO-RE 96 Probe Head. 

* Optional: Vial Cap Management System can be used with Microlab STARlet IVD and Seegene STARlet. 

** Optional: AIOS can be used with Seegene STARlet. 
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3.  Preparation for Real-time PCR 

Note: When using Microlab NIMBUS IVD, Microlab STARlet IVD, Seegene NIMBUS or 

Seegene STARlet for this step, refer to each operation manual. 

Note: The correct tubes and caps must be used (see MATERIALS REQUIRED BUT NOT 

PROVIDED). 

Note: Aerosol resistant filter tips and tight gloves must be used when preparing specimens. Use an 

extreme care to ensure no cross-contamination. 

Note: Completely thaw the reagents on ice. 

Note: Spin down the reagent tubes to remove drops from the inner cap. 

Note: The steps A~D are automatically processed on Microlab NIMBUS IVD, Microlab 

STARlet IVD, Seegene NIMBUS and Seegene STARlet. Refer to each operation manual. 

 

A.  Prepare PCR Mastermix. 

5 L 4X HPV HR TOM 

5 L EM1 

5 L RNase-free Water 

15 L Total volume of PCR Mastermix 

Note: Calculate the necessary amount of each reagent needed based on the number of reactions 

(samples + controls). 

 

B.  Mix by inverting 5 times or quick vortex, and spin down. 

C.  Aliquot 15 L of the PCR Mastermix into PCR tubes. 

D.  Add 5 L of each sample’s nucleic acids into the tube containing PCR Mastermix. 

15 L 

5 L 

PCR Mastermix  

Sample’s nucleic acid 

20 L Total volume of reaction 

Note: Use a new sterile pipette tip for each sample. 

Note: For Negative Control (NC), use 5 µL of RNase-free Water instead of sample’s nucleic acid. 

Note: For Positive Control (PC), use 5 µL of each HPV HR PC1, PC2 and PC3. 

Note: Please be careful not to cross-contaminate the PCR Mastermix and samples with the 

Positive Control. 

Note: Do not label the cap of the reaction tubes as fluorescence is detected through the cap. 
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⚫ Positive Control 

There are three Positive Control tubes included in the kit; HPV HR PC1, PC2 and PC3. 

Each PC includes clones for 5 targets. 

Note: To run the Positive Control reaction, prepare three PCR tubes.  

(See the results below.) 

 

Positive control 

 

 

 

 

  

66 45 58 51 59 16 33 39 52 IC 35 18 56 68 31

P C 1 + - - + - - + - - + - - + - - P ositive C ontrol (+)

P C 2 - + - - + - - + - - + - - + - P ositive C ontrol (+)

P C 3 - - + - - + - - + - - + - - + P ositive C ontrol (+)

A uto interpretation
F A M H E X C al R ed 610 Q uasar 670 Q uasar 705

N am e
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REAL-TIME PCR INSTRUMENT SET UP AND RESULTS ANALYSIS 

 

1. CFX96TM Real-time PCR Detection System (CFX ManagerTM Software-IVD v1.6) 

 

1.1. Real-time PCR Instrument set up 

Note: CFX96TM Real-time PCR Detection System (Bio-Rad) experiment setup can be divided 

into three steps: Protocol Setup, Plate Setup and Start Run. 

 

A.  Protocol Setup 

 

1)  In the main menu, select File → New → Protocol to open Protocol Editor.  

 

Fig. 1. Protocol Setup 
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2)  In Protocol Editor, define the thermal profile as follows: 

 

   i)  cyclic-CMTA (Melt analysis of three times)  

Step Temperature Duration  No. of cycles 

1 50°C 4 min   

2 95°C 15 min   

3 95°C 30 sec  

30 
4 60°C 1 min  

5 72°C 30 sec  

6 GOTO 3, 29 more times  

7 55°C 30 sec   

8* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

9 95°C 30 sec  

10 
10 60°C 1 min  

11 72°C 30 sec  

12 GOTO 9, 9 more times  

13 55°C 30 sec   

14* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

15 95°C 30 sec  

10 
16 60°C 1 min  

17 72°C 30 sec  

18 GOTO 15, 9 more times  

19 55°C 30 sec   

20* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

*Note: Plate Read at Steps 8, 14 and 20. Fluorescence is detected at Melting. 
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ii)  End point-CMTA (Melt analysis of one time) 

Step Temperature Duration  No. of cycles 

1 50°C 4 min   

2 95°C 15 min   

3 95°C 30 sec  

50 
4 60°C 1 min  

5 72°C 30 sec  

6 GOTO 3, 49 more times  

7 55°C 30 sec   

8* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

*Note: Plate Read at Step 8. Fluorescence is detected at Melting.  
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Fig. 2. Protocol Editor (cyclic-CMTA) 

 

 

Fig. 3. Protocol Editor (End point-CMTA) 

 

3)  Click on Sample Volume to directly edit the 20 µL.  
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4)  Click OK and save the protocol to open the Experiment Setup window. 

 

Fig. 4. Experiment Setup Protocol (cyclic-CMTA) 

 

 

Fig. 5. Experiment Setup Protocol (End point-CMTA) 
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B.  Plate Setup 

 

1)  From Plate tab in Experiment Setup, click Create New to open Plate Editor window. 

 

Fig. 6. Plate Editor 

 

2)  Click Select Fluorophores to indicate the fluorophores (FAM, HEX, Cal Red 610, Quasar 

670 and Quasar 705) that will be used and click OK.  

 

Fig. 7. Select Fluorophores (FAM, HEX, Cal Red 610, Quasar 670 and Quasar 705) 
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3)  Select the wells where the PCR tube will be placed and select its sample type from the 

Sample Type drop-down menu. 

     - Unknown: Clinical samples 

     - Negative Control 

     - Positive Control 

 

4)  Click on the appropriate checkboxes (FAM, HEX, Cal Red 610, Quasar 670 and Quasar 

705) to specify the fluorophores to be detected in the selected wells. 

 

5)  Type in Sample Name and PC (PC1, PC2 and PC3), and then press enter key. 

 

6)  In Settings of the Plate Editor main menu, choose the Plate Size (96 wells) and Plate 

Type (BR White).  

  

Fig. 8. Plate Setup 

 

7)  Click OK to save the new plate. 
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8)  You will be returned to the Experiment Setup window.  

 

Fig. 9. Experiment Setup: Plate 

 

9)  Click Next to start run. 

 

C.  Start Run 

 

1)  From Start Run tab in Experiment Setup, click Close Lid to close the instrument lid.  

 

Fig. 10. Close Lid 
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2)  Select the instrument checkbox and click Start Run. 

 

3)  Store the run file either in My documents or in the designated folder. Input the file name, 

click SAVE, and the run will start. 

 

1.2. Data Analysis  

 

A.  Create folders for data export 

 

A-1.  cyclic-CMTA 

 

•  When using ‘Export All Data Sheets to Excel’ function (See page 32) 

1)  To save data from each melt curve detection step from the results file, create three folders 

for each step: “1” for data from step 8, “2” for data from step 14, and “3” for data from step 20. 

 

•  When using ‘Seegene Export’ function (See page 36) 

1)  To save data from all of the melt curve detection steps from the results file, create one 

folder.  

2)  Folder name may be as desired by the user (For ‘Seegene Export’ function, MeltStep8, 

MeltStep14 and MeltStep20 are automatically created to save each melt point data under the 

folder created by the user). 

 

A-2.  End point-CMTA 

 

1)  To save data for melt point from result file, create one folder.  

2)  Folder name may be as desired by the user. 
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B.  Pre-settings for Data Analysis in CFX ManagerTM 

 

B-1.  Using ‘Export All Data Sheets to Excel’ function 

 

1)  After the test, click the Melt curve tab to confirm the Melt Peak results.  

  

Fig. 11. Melt Peak results 
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2)  Select Step number “8” and select “Export All Data Sheets to Excel” from Tools menu. 

Note: Select “Export All Data Sheets to Excel” directly in case of End point-CMTA.  

 

 

 

Fig. 12. Export All Data Sheets to Excel 
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3)  Save the result to the specified folder “1”. 

Note: In case of End point-CMTA, results can be saved in any folder. 

 

Fig. 13. Export all data from spreadsheets to designated folder 

 

4)  Make sure that the results have been saved to the folder “1”. 

 

Fig. 14. Exported Result files 

 

Note: Skip 5) ~ 7) steps and process next analysis stage in case of End point-CMTA. 
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5)  Return to step 2) and select Step number “14”. Repeat steps 3) & 4) and save data in 

designated folder “2”. 

 

6)  Return back to step 2) and select Step number “20”. 

 

7)  Repeat steps 3) & 4) and save data in “3” folder. Data of each step number is saved 

as shown below.  

 

Step number Designated folder 

8 1 

14 2 

20 3 
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B-2.  Using ‘Seegene Export’ function 

 

1)  After the test, click the Melt Curve tab to confirm the Melt Peak results.  

 

Fig. 15. Melt Peak results 

 

2)  Select Seegene Export from Tools menu.  

 

Fig. 16. Seegene Export 
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3)  Choose a location to save data and click OK. 

 

Fig. 17. Seegene Export to designated folder 

 

C.  Settings for Data Analysis in Seegene Viewer 

 

1)  Open Seegene Viewer program, and click Option to select CFX96 in the Instrument. 

 

Fig. 18. Seegene viewer 
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2) Click Open to find the saved file in folder "1"or folder “MeltStep8”, open the results file, and 

select the test kit from the PRODUCT menu. 

Note: Please find the saved data in arbitrary folder in case of End point-CMTA. 

 

Fig. 19. Settings for Data Analysis in Seegene Viewer 

 

Note: Please verify the type of tube when selecting test kit (8 strip / 96 plate / 96 film). 

 

3)  Check the result for each well.  

 

Fig. 20. Test result on Seegene Viewer  
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2. CFX96TM Dx System (CFX ManagerTM Dx Software v3.1) 

 

2.1.  Real-time PCR Instrument set up 

Note: CFX96TM Dx System (Bio-Rad) experiment setup can be divided into three steps: 

Protocol Setup, Plate Setup, and Start Run. 

 

A.  Protocol Setup 

 

1)  In the main menu, select File → New → Protocol to open Protocol Editor.  

  

Fig. 1. Protocol Setup 
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2)  In Protocol Editor, define the thermal profile as follows: 

 

   i)  cyclic-CMTA (Melt analysis of three times) 

Step Temperature Duration  No. of cycles 

1 50°C 4 min   

2 95°C 15 min   

3 95°C 30 sec  

30 
4 60°C 1 min  

5 72°C 30 sec  

6 GOTO 3, 29 more times  

7 55°C 30 sec   

8* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

9 95°C 30 sec  

10 
10 60°C 1 min  

11 72°C 30 sec  

12 GOTO 9, 9 more times  

13 55°C 30 sec   

14* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

15 95°C 30 sec  

10 
16 60°C 1 min  

17 72°C 30 sec  

18 GOTO 15, 9 more times  

19 55°C 30 sec   

20* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

*Note: Plate Read at Steps 8, 14 and 20. Fluorescence is detected at Melting. 
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ii)  End point-CMTA (Melt analysis of one time) 

Step Temperature Duration  No. of cycles 

1 50°C 4 min   

2 95°C 15 min   

3 95°C 30 sec  

50 
4 60°C 1 min  

5 72°C 30 sec  

6 GOTO 3, 49 more times  

7 55°C 30 sec   

8* Melting curve 55°C ~ 85°C (5 s / 0.5°C)   

*Note: Plate Read at Step 8. Fluorescence is detected at Melting.  
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Fig. 2. Protocol Editor (cyclic-CMTA) 

 

 

Fig. 3. Protocol Editor (End point-CMTA) 

 

3)  Click the box next to Sample Volume to directly input 20 μL.  
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4)  Click OK and save the protocol to open the Run Setup window. 

 

Fig. 4. Run Setup Protocol (cyclic-CMTA) 

 

 

Fig. 5. Run Setup Protocol (End point-CMTA) 
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B.  Plate Setup 

 

1)  From Plate tab in Run Setup, click Create New to open Plate Editor window.  

 

Fig. 6. Plate Editor 

 

2)  Click Select Fluorophores to indicate the fluorophores (FAM, HEX, Cal Red 610, Quasar 

670 and Quasar 705) that will be used and click OK.  

 

Fig. 7. Select Fluorophores (FAM, HEX, Cal Red 610, Quasar 670 and Quasar 705) 
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3)  Select the wells where the PCR tube will be placed and select its sample type from the 

Sample Type drop-down menu. 

     - Unknown: Clinical samples 

     - Negative Control 

     - Positive Control 

 

4)  Click on the appropriate checkboxes (FAM, HEX, Cal Red 610, Quasar 670 and Quasar 

705) to specify the fluorophores to be detected in the selected wells. 

 

5)  Type in Sample Name and PC (PC1, PC2 and PC3), and then press enter key. 

 

6)  In Settings of the Plate Editor main menu, choose the Plate Size (96 wells) and Plate 

Type (BR White). 

  

Fig. 8. Plate Setup 

 

7)  Click OK to save the new plate. 
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8)  You will be returned to the Run Setup window. 

 

Fig. 9. Run Setup: Plate 

 

9) Click Next to start run. 

 

C.  Start Run 

 

1)  From Start Run tab in Run Setup, click Close Lid to close the instrument lid.  

  

Fig. 10. Close Lid 
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2)  Click Start Run. 

 

3)  Store the run file either in My Documents or in a designated folder. Input the file name, click 

SAVE and the run will start.  

 

2.2.  Data Analysis  

 

A.  Create folders for data export 

 

A-1.  cyclic-CMTA 

 

• When using ‘Export All Data Sheets to Excel’ function (See page 48) 

1)  To save data from each melt curve detection step from the results file, create three folders 

for each step: “1” for data from step 8, “2” for data from step 14, and “3” for data from step 20. 

 

• When using ‘Seegene Export’ function (See page 52) 

1)  To save data from all of the melt curve detection steps from the results file, create one 

folder.  

2)  Folder name may be as desired by the user (For 'Seegene Export' function, MeltStep8, 

MeltStep14, and MeltStep20 are automatically created to save each melt point data under the 

folder created by the user). 

 

A-2.  End point-CMTA 

 

1)  To save data for melt point from result file, create one folder.  

2)  Folder name may be as desired by the user. 
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B.  Pre-settings for Data Analysis in CFX ManagerTM  

 

B-1.  Using ‘Export All Data Sheets to Excel’ function 

 

1)  After the test, click the Melt Curve tab to confirm the Melt Peak results. 

  

Fig. 11. Melt Peak results 
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2) Select Step Number “8” and select “Export All Data Sheets (Excel 2007 or Excel 2003)” 

from Export menu. 

Note: Select “Export All Data Sheets (Excel 2007 or Excel 2003)” directly in case of End 

point-CMTA.  

 

 

 

Fig. 12. Export All Data Sheets to Excel 
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3)  Save the result to the specified folder “1”. 

Note: In case of End point-CMTA, results can be saved in any folder. 

 

Fig. 13. Export all data from spreadsheets to designated folder 

 

4)  Make sure that the results have been saved to the folder “1”. 

 

Fig. 14. Exported Result files 

 

Note: Skip 5) ~ 7) steps and process next analysis stage in case of End point-CMTA. 
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5)  Return to step 2) and select Step number “14”. Repeat steps 3) & 4) and save data in 

designated folder “2”. 

 

6)  Return back to step 2) and select Step number “20”. 

 

7)  Repeat steps 3) & 4) and save data in “3” folder. Data of each step number is saved 

as shown below.  

 

Step number Designated folder 

8 1 

14 2 

20 3 
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B-2.  Using ‘Seegene Export’ function  

 

1)  After the test, click the Melt Curve tab to confirm the Melt Peak results. 

 

Fig. 15. Melt Peak results 

 

2)  Select Seegene Export from Export menu. 

 

Fig. 16. Seegene Export 
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3)  Choose a location to save data and click OK. 

 

Fig. 17. Seegene Export to designated folder 

 

C.  Settings for Data Analysis in Seegene Viewer 

 

1) Open Seegene Viewer program, and click Option to select CFX96 Dx in the Instrument. 

 

Fig. 18. Seegene viewer 
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2) Click Open to find the saved file in folder "1"or folder “MeltStep8”, open the results file, and select 

the test kit from the PRODUCT menu. 

Note: Please find the saved data in arbitrary folder in case of End point-CMTA. 

 

Fig. 19. Settings for Data Analysis in Seegene Viewer 

 

Note: Please verify the type of tube when selecting test kit (8 strip / 96 plate / 96 film). 

 

3)  Check the result for each well.  

 

Fig. 20. Test result on Seegene Viewer 
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RESULTS 

 

1.  Analyte Information 
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2.  Interpretation of Results 

 

A.  cyclic-CMTA  

 

HPV Result* IC Result* Interpretation 

+++ or ++ or + +++ or ++ 
Target Nucleic acid, detected 

- Target HPV type identification 

+++ or ++ or + + or - 

Target Nucleic acid, detected** 

- Target HPV type identification 

- Additional HPV genotypes which may be present were 

not detected 

- +++ or ++ Target Nucleic acid, not detected 

- + or - 

Invalid 

- Weak or negative IC signal suggests inadequate 

specimen collection, processing or the presence of 

inhibitors. 

- Repeat the test from the step of nucleic acid extraction 

using another aliquot of the original specimen. 

 

* Internal Control or any other signals are not observed: see TROUBLESHOOTINGS (Page 

60). 

** Internal Control signal could be reduced or absent due to high titer of pathogens. 

 

Result 

cyclic-CMTA 

 (cyclic-Catcher Melting Temperature Analysis) 

First CMTA point Second CMTA point Third CMTA point 

+++ + + + 

++ - + + 

+ - - + 

- - - - 
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B.  End point-CMTA 

 

HPV Result* IC Result* Interpretation 

+ + 
Target Nucleic acid, detected 

- Target HPV type identification 

+ - 

Target Nucleic acid, detected** 

- Target HPV type identification 

- Additional HPV genotypes which may be present were 

not detected 

- + Target Nucleic acid, not detected 

- - 

Invalid 

- Negative IC signal suggests inadequate specimen 

collection, processing or the presence of inhibitors. 

- Repeat the test from the step of nucleic acid extraction 

using another aliquot of the original specimen. 

 

* Internal Control or any other signals are not observed: see TROUBLESHOOTINGS (Page 

60). 

** Internal Control signal could be reduced or absent due to high titer of pathogens. 
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3.  Application to Clinical Samples 

 

A.  cyclic-CMTA 

Melt Peak-1st (First CMTA point) 

 

Melt Peak-2nd (Second CMTA point) 

 

Melt Peak-3rd (Third CMTA point) 

 

 

Auto Interpretation Remark Quasar 670 FAM HEX Cal Red 610 Quasar 670 Quasar 705 

High-risk HPV 16(+++), 68(+) 
IC 66 45 58 51 59 16 33 39 52 35 18 56 68 31 

+++ - - - - - +++ - - - - - - + - 
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B.  End point-CMTA 

 

 

 

Auto Interpretation Remark Quasar 670 FAM HEX Cal Red 610 Quasar 670 Quasar 705 

High-risk HPV 16, 68 
IC 66 45 58 51 59 16 33 39 52 35 18 56 68 31 
+ - - - - - + - - - - - - + - 
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TROUBLESHOOTINGS 

 

AnyplexTM II HPV HR Detection 

OBSERVATION PROBABLE CAUSES SOLUTION 

No signal 

The fluorophores for data 

analysis do not comply with 

the protocol 

Select the correct fluorophores for data analysis. 

Incorrect PCR cycle or 

machine temperature 

Please check the PCR conditions and repeat the 

PCR under the correct setting if necessary. 

Leaving reagents at room 

temperature for a long time 

or incorrect storage condition 

Please check the storage conditions (See page 11) 

and the expiry date (see the kit label) of the reagents 

and use a new kit if necessary. 

Incorrect programming 

Repeat the detection procedure with a correct 

setting. 

Nucleic acid extraction failure 

Make sure that you use a recommended extraction 

method. 

Error in specimen collection 

If both target and IC signal were not observed that 

means specimen collected inappropriately. Recollect 

the specimen. 

No Internal 

Control signal 

High load of pathogen's 

nucleic acid 

Without detection of IC signal, target signal is 

considered as “detected” when target is observed. 

For IC signal detection, re-test by diluting samples. 

① Dilute the template nucleic acid in RNase-free 

water to 10X-100X and repeat PCR. 

② Dilute the specimen in PBS to 10X-100X and 

repeat from extraction. 

Presence of PCR Inhibitor 

Putative false 

positive or 

target signals 

observed in 

Negative Control 

Presence of cross 

contamination 

Decontaminate all surfaces and instruments with 

sodium hypochlorite and ethanol. Use only filter tips 

during the extraction procedure. Change tips among 

tubes. Repeat the nucleic acid extraction with the 

new set of reagents. 

Cross-contamination 

between PC1, 2 and 3 

Restart from extraction step or real-time PCR step. 
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AnyplexTM II HPV HR Detection 

OBSERVATION PROBABLE CAUSES SOLUTION 

Putative false 

negative or No 

signals 

observed in 

Positive Control 

Error in specimen collection Recollect the specimen. 

Incorrect storage of the 

specimen 

Recollect the specimen and repeat the whole 

process. Make sure the product is stored in 

recommended conditions. 

Error in nucleic acid 

extraction 

Re-extract the nucleic acid. 

Error in adding nucleic acid 

to corresponding PCR tubes 

Check the sample numbers for nucleic acid 

containing tubes and make sure to add nucleic acid 

into correct PCR tubes during detection process. 

Presence of inhibitor 
Dilute the specimen in PBS (10~100x) and repeat 

from extraction step with the diluted specimen. 

The fluorophores for data 

analysis do not comply with 

the protocol 

Select the correct fluorophores for data analysis. 

Incorrect programming Repeat the PCR with corrected setting. 

Incorrect PCR mixture 

Check whether all components are added or not 

(Sensitivity is compromised when precomposed 

premix is used). All reagents must be homogenized 

and spun down before use. 

Leaving reagents at room 

temperature for a long time 

or incorrect storage condition 

Please check the storage condition and the expiry 

date (see the kit label) of the reagents and use a 

new kit if necessary. 

 

  



  

 
62                                                                  11/2022 V2.13 

 
AnyplexTM II HPV HR Detection 

 

 

PERFORMANCE 

 

1.  Specificity  

The high specificity of the AnyplexTM II HPV HR Detection is ensured by the primers 

specifically designed for the targets in interest and the reaction condition. AnyplexTM II 

HPV HR Detection has been tested for cross-reactivity in 80 different pathogens: result 

illustrated PCR amplifications in targets only. 

 

Organism Strain No. Test Result† 

Acinetobacter baumannii ATCC 15150 Not detected 

Bacteroides fragilis ATCC 25285D Not detected 

Chlamydia trachomatis ATCC VR-577 Not detected 

Corynebacterium genitalium ATCC 33030 Not detected 

Enterobacter cloacae KCTC 13047 Not detected 

Enterococcus faecalis ATCC 700802D-5 Not detected 

Escherichia coli ATCC 15489 Not detected 

Fusobacterium nucleatum ATCC 25586D-5 Not detected 

Gardnerella vaginalis ATCC 14019 Not detected 

Haemophilus ducreyi ATCC 33940 Not detected 

Klebsiella pneumoniae ATCC 13883 Not detected 

Lactobacillus acidophilus ATCC 4357D-5 Not detected 

Lactobacillus crispatus ATCC 33820 Not detected 

Lactobacillus gasseri ATCC 33323 Not detected 

Lactobacillus iners ATCC 55195 Not detected 

Lactobacillus jensenii ATCC 25258 Not detected 

Mobiluncus curtisii ATCC 35241 Not detected 

Mobiluncus mulieris ATCC 35243 Not detected 

Neisseria gonorrhoeae ATCC 700825D Not detected 

Neisseria meningitidis ATCC 700532D Not detected 

Neisseria sicca ATCC 29256 Not detected 

Peptostreptococcus anaerobius ATCC 49031D-5 Not detected 

Propionibacterium acnes ATCC 6919 Not detected 

Proteus mirabilis ATCC 12453 Not detected 
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Organism Strain No. Test Result† 

Proteus vulgaris ATCC 6059 Not detected 

Pseudomonas aeruginosa ATCC 15522 Not detected 

Pseudomonas fluorescens KCTC 49642 Not detected 

Serratia marcescens ATCC 27137D-5 Not detected 

Staphylococcus aureus subsp.aureus ATCC 29213 Not detected 

Streptococcus agalactiae ATCC BAA-611D Not detected 

Streptococcus mitis ATCC 49456D-5 Not detected 

Streptococcus pyogenes ATCC 700294D-5 Not detected 

Trichomonas vaginalis ATCC 30001D Not detected 

Ureaplasma urealyticum ATCC 33695 Not detected 

Candida albicans ATCC 14053 Not detected 

Cytomegalovirus ATCC VR-807 Not detected 

Epstein-Barr virus  ATCC VR-602 Not detected 

Herpes simplex virus 1 ATCC VR-260 Not detected 

Herpes simplex virus 2 ATCC VR-734 Not detected 

Human Adenovirus 40 ATCC VR-931 Not detected 

HPV1 ATCC 45021 Not detected 

HPV2 ATCC 45022 Not detected 

HPV6  ATCC 45150D Not detected 

HPV11  ATCC 45151D Not detected 

HPV26  Korean isolate Not detected 

HPV34 Korean isolate Not detected 

HPV40  Korean isolate Not detected 

HPV42  Korean isolate Not detected 

HPV43  ATCC 40339 Not detected 

HPV44  Korean isolate Not detected 

HPV53  Korean isolate Not detected 

HPV54  Korean isolate Not detected 

HPV61  Korean isolate  Not detected 

HPV62 Korean isolate Not detected 

HPV69  Korean isolate  Not detected 
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Organism Strain No. Test Result† 

HPV70  Korean isolate  Not detected 

HPV71 Korean isolate Not detected 

HPV72 Korean isolate Not detected 

HPV73  Korean isolate  Not detected 

HPV81 Korean isolate Not detected 

HPV82  Korean isolate  Not detected 

HPV83 Korean isolate Not detected 

HPV84 Korean isolate Not detected 

HPV102 Korean isolate Not detected 

HPV16  ATCC 45113D Detected (HPV16) 

HPV18  ATCC 45152D Detected (HPV18) 

HPV31  ATCC 65446 Detected (HPV31) 

HPV33  Korean isolate Detected (HPV33) 

HPV35  ATCC 40330 Detected (HPV35) 

HPV39  Korean isolate Detected (HPV39) 

HPV45  Korean isolate Detected (HPV45) 

HPV51  Korean isolate Detected (HPV51) 

HPV52  Korean isolate Detected (HPV52) 

HPV56  ATCC 40549 Detected (HPV56) 

HPV58  Korean isolate  Detected (HPV58) 

HPV59  Korean isolate  Detected (HPV59) 

HPV66  Korean isolate  Detected (HPV66) 

HPV68  Korean isolate  Detected (HPV68) 

SiHa Cell  KCLB 30035  Detected (HPV16) 

HeLa Cell KCLB 10002  Detected (HPV18) 

†To prove the availability of the results, the experiment was repeated three times. 

 

※ ATCC: American Type Culture Collection 

KCTC: Korean Collection for Type Culture 

KCLB: Korean Cell Line Bank 
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2. Sensitivity 

In order to determine the sensitivity of AnyplexTM II HPV HR Detection, a standard serial 

dilution has been set up from 105 to 100 copies/reaction plasmid DNA and from 5 x 103 to 101 

cells/mL SiHa cell (HPV16) and HeLa cell (HPV18) and analyzed with AnyplexTM II HPV HR 

Detection. Detection limit for AnyplexTM II HPV HR Detection was 50 copies/reaction for 

plasmid DNA and 500 cells/mL for SiHa cell (HPV16) and HeLa cell (HPV18). 

 

3. Reproducibility 

A criterion for reproducibility test is to obtain the same results over time. The percent (%) 

agreement with expected result should be over 95%. Reproducibility test using cloned pDNAs 

was tested with 3 different product lots, 3 different experimenters, 3 different laboratory sites, 

and 7 different time points. The overall agreement for the AnyplexTM II HPV HR Detection was 

99.4%. 

 

4. Interfering substances 

Interference testing was carried out using human whole blood and cervical mucus as external 

materials not related with target species. AnyplexTM II HPV HR Detection showed clear results 

that there is no influence on results observed under conditions mentioned above. 
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KEY TO SYMBOLS 

 

Symbol Explanation 

 

In vitro diagnostic medical device 

 

Batch code 

 

Catalogue number 

 

Use-by date 

 

Upper limit of temperature 

 

Caution 

 

Oligonucleotide Mix for amplification and detection 

 

RNase-free Water 

 
Positive Control (PC) 

 

PCR Master Mix or Detection Mix 

 

Manufacturer 

 

Date of Manufacture 

 

Consult instructions for use 

 

Authorized representative in the European community 

 
Contains sufficient for <n> tests 

 
Unique Device Identifier 

 
Reaction barcode for automated extraction system 
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ORDERING INFORMATION 

 

Cat. No. Product Size 

AnyplexTM II HPV Series 

HP7E00X AnyplexTM II HPV HR Detection 100 rxns 

HP10380Z AnyplexTM II HPV HR Detection 25 rxns 

HP7S00X AnyplexTM II HPV28 Detection 100 rxns 

HP10379Z AnyplexTM II HPV28 Detection 25 rxns 

 

Seeplex® HPV Series 

HP6401Y Seeplex® HPV4A ACE Screening 50 rxns 

 

Accessory products 
 

SG1701 Ribo_spin vRD(Viral RNA/DNA Extraction Kit) 50 preps 

 

Automated extraction system 

65415-02 Microlab NIMBUS IVD EA 

173000-075 Microlab STARlet IVD EA 

65415-03 Seegene NIMBUS EA 

67930-03 Seegene STARlet EA 

744300.4.UC384 STARMag 96 X 4 Universal Cartridge Kit 384T / 1box 

EX00013C STARMag 96 X 4 Viral DNA/RNA 200 C Kit 384T / 1box 

EX00003P STARMag 96 UniPlate 96 T / 1box 

EX00004T STARMag 96 UniTube 96 T / 1box 

EX00036P STARMagTM S96H N kit 480T / 1box 

EX00037P STARMagTM S96H N kit 960T / 1box 

SG71100 SEEPREP32 EA 

EX00009P STARMag 96 ProPrep (Plate Type) 96T / 1box 

EX00009T STARMag 96 ProPrep (Tube Type) 96T / 1box 

EX00017P STARMag 96 ProPrep C (Plate Type) 96T / 1box 

EX00017T STARMag 96 ProPrep C (Tube Type) 96T / 1box 

6600532-01 Vial Cap Management System EA 

SG72100 AIOS  EA 

 


